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What’s Inside this Issue: No Presentations - Sunday 21st August 2022

Apple-Q On-line meetings
are not getting a good

response from members
by Leigh Harvey

Leigh he has put a lot of thought into trying to get more
member input into the on-line meetings.

He has selected a program to enable members to have an
easily used on-line facility which only needs people to log
in and use the program to facilitate your attendance at
the meeting with voice and/or video.

He has explained how to get it to work and how easily it
can be used for meetings. Please log on and participate in
your organisation.

His report is on page 4.

® Apple-Q Server

See Levels & Perks

Meeting
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Judith’s Findings
All purpose digital tool

Vectornator on iPad
by Judith Hall & Leigh Harvey

Judy has once again found an all-purpose tool for the iPad.
The Vectornator is a magic machine for manipulating digital
images.

Also a glimpse of what is coming later in the year with a slew
of releases utilising the new speed and effectiveness of the
M2 processor.

We also have more new video tutorials from Gary at
MacMost.

Read about the new finds on pages 18-21.



Calendar 2022-23

August 2022

8th  Apple-Bug article Reminder

21st  Apple-Bug & Meeting

28th Training Seminars

September 2022

5th Apple-Bug Deadline for September
18th Apple-Bug & Meeting

25th Training Seminars

October 2022

3rd Apple-Bug Deadline for October
16th Apple-Bug & Meeting

23rd Training Seminars

November 2022

7th  Apple-Bug Deadline for November
20th Apple-Bug & On-line Meeting
27th Training Seminars

January 2023

2nd Apple-Bug Deadline for January
15th Apple-Bug & Meeting
22ndTraining Seminars

February 2023

6th  Apple-Bug Deadline for February

19th Apple-Bug & Meeting
26th Training Seminars

If you have an Apple problem call a volunteer
expert on our Help Line.
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Help Line

Please call only during the times shown and
remember that the volunteer will expect to have
completed the call within the times shown. In
other words don’t call at 8.55pm and expect a 15
minute help session. Remember these are
volunteers and they may not always be available
at these times. Email prior to call to be certain.

General Help - Leigh Harvey
Available: 10-11:30am, 2-5:30pm, 7-9pm
Except: Saturday from 11:30am, Sunday
until 7pm

Phone: (07) 33412947

Email: information@apple-q.org.au

Apple II General - Jeff Sellers
Available: gam-4pm - Saturday & Sunday only

Phone: (07) 33591339

Like helping others every now and then?
Volunteer and add your name to these
lists.

Email to: editor@apple-q.org.au
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President’s Report vy Leigh Harvey

First of all, there was a problem with getting last month’s Apple-Bug
out on time which caused it not to be available until the Saturday
afternoon before Sunday’s meeting. It is hoped that this has been
fixed and this issue will a bit earlier - however I am running late
with this month’s articles. I assume that this was the reason for the
very low participation rate at Sunday’s Meeting.

Last month only 12 Apple-Bugs were downloaded out of a
membership of over 50 members. This is the number that were
downloaded from the main Apple-Q site so there may also be
members who download it directly from the Apple-Q-Cloud where it
is stored.

Once again, as far as I am aware, I am the only contributor in this
month’s Apple-Bug (except for input from Jude). There were a
couple of people asking about what to write an article but I have not
seen any additional articles.

You can write about anything Apple, or related to Apple products,
and how you use them. As stated in last month’s issue, I have certain
areas that I have an interest in and no interest in other areas (eg
social media). I am certain there are members that have experiences
that would be great to share with others. You may have interests
that vary from mine that members might find very interesting.
Please think about it and let me or our Editor (Bill) know.

Did you ask anyone if they would like to join Apple-Q
today? Did they need help with learning more about
the many things you can do with a Macintosh?
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Special Apple Event - Spring 2022

This Spring (likely September or October) there could be a big Apple
Event that, according to rumours, may see the release of many new
M2 based Macs and even iPads. In June this year, at the World
Wide Developers’ Conference 2022 (see our June Edition), Apple
unveiled the successor to the groundbreaking M1 silicon chip along
with a couple of new products - just to give us a taste of what is to
come. The new generation M2 chip is an incredible leap in
technology. It greatly increases its capabilities while still using very
little energy. This is vital in a would with massive numbers of
portable devices that rely on batteries to keep them running. Intel
seems to be concentrating on powerful processors at the expense of
energy, with some of their devices requiring up to nine times the
energy in order to be up to the speed of the M2 chip.

What is even more impressive is that the M2 is Apple’s entry level
chip - it is still to release the Max, Pro, and Ultra versions.

Another thing that may change on Apple iPhones and iPads in the
near future is the Lightning connector. The EU ruled that all
portable devices shall only have a USB-C connector to power them.
Apple has been using this on the iPad Pros which does allow
connecting external peripherals (eg flash drives) much easier. So
personally I think that this is a good thing.

Announcing macOS 12.5.1, i0S 15.6 and iPadOS 15.6.1, important
security releases out today, our time. I haven’t checked outApple Tv
4Ks, but I think there is something there for them too. We will also
see version updates to all of Apple’s Operating Systems very soon.



How To Join our Apple-Q On-line Meetings by Leigh Harvey

We have 24 members signed up to the Apple-Q Meetings Server
however the most that we have ever had for a meeting on the server
was around 10 to 12 people (during our last meeting).

Many have joined the server but have only been seen once or are
rarely on. Once you have gone through the process of joining the
rest is very simple. It takes less than 30 seconds - just open the
Discord app then three clicks of your mouse and you are in the
meeting. Don’t believe me, then watch this video that I made!

Select the Apple-Q Server on the left (see bottom screenshot).

. Select the Meeting heading to join the Meeting. Clicking on it a
second time will bring up the group view of all of the members
who are currently in the meeting (see screenshot on right).

Apple-Q Server

v

x :—

Server Boosts are here! Rally your
community to boost your server.

See Levels & Perks

MEETINGS

> AGM
Meeting
G% President
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Server Boosts are here! Rally your
community to boost your server.

See Levels & Perks

Meeting
®

No one else is here yet. Invite people to join you!
Invite
e R

@ Video B3 Screen
® e (0 0o

3. Selecting Video will turn on your camera if you wish others to
see you. Clicking on the Microphone icon will toggle it on/off.

4. Closing the app will disconnect you - no need to log off.

I am often just on-line and also in a Chat Room - feel free to join me
if you need help or wish to chat. Email or phone if you need help.

See you Sunday!



https://cloud.apple-q.org.au/index.php/s/wEka2YnFKpAFZfZ
https://cloud.apple-q.org.au/index.php/s/wEka2YnFKpAFZfZ

Alert: Apple-Bug Downloads and On-line Meetings by Leigh Harvey

[Reprinted from the July 2022 issue of the Apple-Bug]

We currently have over 50 Apple-Q members of which only eleven
downloaded last month’s Apple-Bug directly from the Apple-Q web
site. Members can also download it directly from the Apple-Q-Cloud
where it is stored or using Apple-Q-Cloud Sync (which places a copy
of the Apple-Bug directly on your computer as soon as it is available
so there may be others that have downloaded the Bug).

In May there were 14 copies downloaded and 17 in April. Apart from
Jude’s article I am currently the only contributor to the Apple-Bug.
It would be great to have others writing articles as this gives
members a much better perspective and greater variety of topics
while highlighting other members’ interests. I write about what
interests me and this excludes many other areas that may be of
considerable interest to others. Some members have asked me to
write articles or tutorials about certain topics and I have had to tell
them that I do not know about them nor do I have any interest in
learning about them (eg Social Media).

At the moment I spend a lot of time writing articles (and tutorials)
only to have very few people reading them. The WWDC version that
I wrote, several articles took me days to complete only to have it
downloaded by 11 members. I need to know if we can do
anything different to increase the number of people
downloading the Apple-Bug.

I have made it extremely easy to download the Apple-Bug - once
logged in you can download it with just two clicks. If you do not
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believe me I have created videos showing this with both Firefox and

Safari. (Comment: How about we force-feed the members rather
than rely on them to DL the Bug. in other words, by default, send
each issue by email.)

Since we still do not have a physical meeting site to go to we have
been using an app called Discord to hold on-line meetings. I chose
the Discord app over several others for both its ease of use as well as
unlimited duration and participants. Once you have signed up to
Discord and accepted the invite to the server it takes only three
clicks of the mouse to join in on a meeting. Here is a video to prove
it.

We have 24 people who are members of the Apple-Q Meeting
Server, so all that they have to do to join in on a meeting is to open
the Discord app and click three times.

Meeting attendance has been rather disappointing - the most that
we have had was between 10 to 12 members and that was only once -
most are well below that. I changed the meeting time from 2:00pm
to 4:00pm on the 3rd and 4th Sunday of the month to 1:00pm to
2:55pm to match the afternoon sessions that we had pre-COVID and
that helped a bit. However, considering members no longer have to
travel and can simply click three times at home, the attendance
levels are very disappointing.

If there is something that I can do to help members with
either the Apple-Bug or Meetings Server please let me
know. All suggestions are welcome.


https://cloud.apple-q.org.au/index.php/s/6asLF7qmZQ27oai
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https://cloud.apple-q.org.au/index.php/s/wEka2YnFKpAFZfZ
https://cloud.apple-q.org.au/index.php/s/wEka2YnFKpAFZfZ
https://cloud.apple-q.org.au/index.php/s/wEka2YnFKpAFZfZ

TextEdit: Copy Finder File/Folder Names into Text (Mac) oy Leigh Harvey

I have often needed to copy the names of multiple files within a

Finder window into a text file. An example of this is copying the
names of Apple-Q HowTo Tutorials into an Apple-Bug article or
another HowTo Tutorial so that I may link or reference it.

Below is a Finder folder that contains all of my Gramps tutorials.

i W Q

New Folder Delete Search

L= Apple-Q HowTo- Gramps- Attaching Media (2017-11).pdf

I Apple-Q HowTo- Gramps- Backup your Family Tree (with Media)(2018-07).pdf

I Apple-Q HowTo- Gramps- Clean up your Media Paths (2019-06).pdf

I Apple-Q HowTo- Gramps- Consolidating Media Files (2019-06).pdf

I Apple-Q HowTo- Gramps- Contextual Configuration Settings (2021-10).pdf

I Apple-Q HowTo- Gramps- Custom Installation (2019-06).pdf

k£~ Apple-Q HowTo- Gramps- Export Family Tree as GEDCOM (2020-02).pdf

I~ Apple-Q HowTo- Gramps- Have these two families met? (2019-06).pdf

£ Apple-Q HowTo- Gramps- Import Family Tree from Backup (2018-07).pdf

I Apple-Q HowTo- Gramps- Import Family Tree from GEDCOM (2019-06).pdf

I Apple-Q HowTo- Gramps- Import Family Tree with Media (2022-05).pdf

I« Apple-Q HowTo- Gramps- List of Tutorials (2022-03).pdf

I Apple-Q HowTo- Gramps- Map all known places (2019-06).pdf

I Apple-Q HowTo- Gramps- Organise & Find Places (& GPS)(2019-06).pdf

£ Apple-Q HowTo- Gramps- Transfer to another Mac (Custom Install)(2019-06).pdf
I Apple-Q HowTo- Gramps- Transfer to another Mac (Standard Install)(2019-06).pdf
I < Apple-Q HowTo- Gramps- Video Tutorials (Richard Suthern)(2018-01).pdf

Using my technique I can paste the name of these tutorials into this

article:
Apple-Q HowTo- Gramps- Attaching Media (2017-11).pdf

Apple-Q HowTo- Gramps- Backup your Family Tree (with Media)(2018-07).pdf

Apple-Q HowTo- Gramps- Clean up your Media Paths (2019-06).pdf
Apple-Q HowTo- Gramps- Consolidating Media Files (2019-06).pdf
Apple-Q HowTo- Gramps- Contextual Configuration Settings (2021-10).pdf
Apple-Q HowTo- Gramps- Custom Installation (2019-06).pdf

Apple-Q HowTo- Gramps- Export Family Tree as GEDCOM (2020-02).pdf
Apple-Q HowTo- Gramps- Have these two families met? (2019-06).pdf
Apple-Q HowTo- Gramps- Import Family Tree from Backup (2018-07).pdf

Apple-Q HowTo- Gramps- Import Family Tree from GEDCOM (2019-06).pdf

Apple-Q HowTo- Gramps- Import Family Tree with Media (2022-05).pdf
Apple-Q HowTo- Gramps- List of Tutorials (2022-03).pdf

Apple-Q HowTo- Gramps- Map all known places (2019-06).pdf

Apple-Q HowTo- Gramps- Organise & Find Places (& GPS)(2019-06).pdf
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Here is how:

1. Navigate to where the files are stored and and make sure that it
is in Column View:

o e = % 6 = Bl ®Q
Group Action  Share Path New Folder Delete Search

Gramps

I'= Apple-Q HowTo- Side by Side Map Viewer (2019-07).pdf [ ] Apple-Q HowTo- Gramps- Attaching Media (2017-11).pdf

I Apple-Q HowTo- Windows Ap...32Bit Only,PAF))(2016-07).pdf © Apple-Q HowTo- Gramps- Backup your Family Tree (with Media)(2018-07).pdf

B Gramps L Apple-Q HowTo- Gramps- Clean up your Media Paths (2019-06).pdf
webtrees o Apple-Q HowTo- Gramps- Consolidating Media Files (2019-06).pdf

®
I
I
I
I Apple-Q HowTo- Gramps- Contextual Configuration Settings (2021-10).pdf

I Apple-Q HowTo- Gramps- Custom Installation (2019-06).pdf

E~ Apple-Q HowTo- Gramps- Export Family Tree as GEDCOM (2020-02).pdf

L~ Apple-Q HowTo- Gramps- Have these two families met? (2019-06).pdf

k- Apple-Q HowTo- Gramps- Import Family Tree from Backup (2018-07).pdf

I Apple-Q HowTo- Gramps- Import Family Tree from GEDCOM (2019-06).pdf

I Apple-Q HowTo- Gramps- Import Family Tree with Media (2022-05).pdf

L= Apple-Q HowTo- Gramps- List of Tutorials (2022-03).pdf

I Apple-Q HowTo- Gramps- Map all known places (2019-06).pdf

I Apple-Q HowTo- Gramps- Organise & Find Places (& GPS)(2019-06).pdf

I Apple-Q HowTo- Gramps- Transfer to another Mac (Custom Install)(2019-06).pdf
I Apple-Q HowTo- Gramps- Transfer to another Mac (Standard Install)(2019-06).pdf
I ¥ Apple-Q HowTo- Gramps- Video Tutorials (Richard Suthern)(2018-01).pdf

2. Select all of the items that you wish to copy the names for - you
can click on one and then press Command+A to select all:

Gramps

Ml Apple-Q HowTo- Gramps- Backup your Family Tree (with Media)(2018-07).pdf

M Apple-Q HowTo- Gramps- Have these two families met? (2019-06).pdf

Bl Apple-Q HowTo- Gramps- Import Family Tree from Backup (2018-07).pdf

Bl Apple-Q HowTo- Gramps- Import Family Tree from GEDCOM (2019-06).pdf

B Apple-Q HowTo- Gramps- Import Family Tree with Media (2022-05).pdf
B Apple-Q HowTo- Gramps- List of Tutorials (2022-03).pdf




TextEdit: Copy Finder File/Folder Names into Text (Mac) oy Leigh Harvey (cont...)

3. Copy the selected items by either going to the Edit menu and
select Copy or press Command+C:

@ Finder File View Go Window Help
i @) @ Gramps  Undo Remove Tag “Green” 3#Z
Redo 0¥Z |
<
Back/Forward Cut171 EX (
Copy 17 ltems
Paste . L
Favourites Select All 3BA )
Sl Receni= Show Clipboard x
Applications
o Start Dictation... fnfn
M Utilities Emoji & Symbols ~38Space

Naciimente ||

4. Open TextEdit (within the Applications Folder). A blank file
will open - go to Edit and select Paste and Match Style:

& TextEdit File ormat View Window Help
[ NON ) Undo Cut 8Z
v Helvetica | Reg Redo 0 ¥Z vE
= | E
¥ > » » » » cut a8
0 2 a4 ) i ]
e 8V
Paste and Match Style {8V

Complete

\S®)
Select All BA
Insert >
Attach Files... - 38A
Add Link... #K
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Warning:
Do not just Copy and Paste - either into TextEdit or other
applications. If you do so it most likely will try to paste the
entire contents of all of the files into the document - it could be
very messy and take a long time to complete

This will paste just the names of the items into the TextEdit
document:

@ TextEdit File Edit Format View Window Help

Untitled — E
v @B~ 8B 1uu@dH

v > > | 4 | 4 | 4 | 4 | 4 | 4 | 4 | 4 | 4 | 4
0 2 4 6 8 10 12 14
Apple-Q HowTo- Gramps- Attaching Media (2017-11).pdf
Apple-Q HowTo- Gramps- Backup your Family Tree (with Media)(2018-07).pdf
Apple-Q HowTo- Gramps- Clean up your Media Paths (2019-06).pdf
Apple-Q HowTo- Gramps- Consolidating Media Files (2019-06).pdf
Apple-Q HowTo- Gramps- Contextual Configuration Settings (2021-10).pdf
Apple-Q HowTo- Gramps- Custom Installation (2019-06).pdf
Apple-Q HowTo- Gramps- Export Family Tree as GEDCOM (2020-02).pdf
Apple-Q HowTo- Gramps- Have these two families met? (2019-06).pdf
Apple-Q HowTo- Gramps- Import Family Tree from Backup (2018-07).pdf
Apple-Q HowTo- Gramps- Import Family Tree from GEDCOM (2019-06).pdf
Apple-Q HowTo- Gramps- Import Family Tree with Media (2022-05).pdf
Apple-Q HowTo- Gramps- List of Tutorials (2022-03).pdf
Apple-Q HowTo- Gramps- Map all known places (2019-06).pdf
Apple-Q HowTo- Gramps- Organise & Find Places (& GPS)(2019-06).pdf
Apple-Q HowTo- Gramps- Transfer to another Mac (Custom Install)(2019-06).pdf
Apple-Q HowTo- Gramps- Transfer to another Mac (Standard Install)(2019-06).pdf
Apple-Q HowTo- Gramps- Video Tutorials (Richard Suthern)(2018-01).pdf

r

1v

(1]
[l

Helvetica C | Regular 12

]

=



TextEdit: Copy Finder File/Folder Names into Text (Mac) oy Leigh Harvey (cont...)

6. Go to the Edit menu and choose Select All (or press

Command+A):
@ TextEdit File
00 @

v Helvetica C | Reg

¥ > » » » »
0 2 4
Apple-Q HowTo- Gramps- Att
Apple-Q HowTo- Gramps- Ba
Apple-Q HowTo- Gramps- Cle
Apple-Q HowTo- Gramps- Co
Apple-Q HowTo- Gramps- Co
Apple-Q HowTo- Gramps- Cu
Apple-Q HowTo- Gramps-
Apple-Q HowTo- Gramps- Ha
Apple-Q HowTo- Gramps- Im|
Apple-Q HowTo- Gramps- Im|
Apple-Q HowTo- Gramps- Im|
Apple-Q HowTo- Gramps- Lis
Apple-Q HowTo- Gramps- Me

ormat View Window He
Undo Paste $Z
Redo 0RZ :
Cut dX |
Copy ggc *
Paste #V d
Paste and Match Style {3V
Delete
Complete S
Select All

Insert
Attach Files...
Add Link...

>
038A
#K

7. Then go back to the Edit menu and choose Copy (or

Comand+C)

@ TextEdit File
o0 e®

1v Helvetica

¥ > » » > .
0 2 a /
Apple-Q HowTo- Gramps- At
Apple-Q HowTo- Gramps- Ba
Apple-Q HowTo- Gramps- Cl¢

ormat

Undo Paste
Redo

View Window Hel_p

#»Z
0 38Z

(I

#X

*V

Apple-Q HowTo
Apple-Q HowTo
Apple-Q HowTo
Apple-Q HowTo
Apple-Q HowTo
Apple-Q HowTo

- Gramps- Co
- Gramps- Co
- Gramps- Cu
- Gramps- Ex
- Gramps- Ha
- Gramps- Im|

Paste and Match Style {8V
Delete

Apple-Q HowTo- Gramps- Im|
Apple-Q HowTo- Gramps- Im|
Apple-Q HowTo- Gramps- Lis
Apple-Q HowTo- Gramps- Mz
Apple-Q HowTo- Gramps- Ori
Apple-Q HowTo- Gramps- Tre
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Complete S
Select All BA
Insert >
Attach Files... {0+ $8A
Add Link... $K
Find > o

8. Then go to the document where you wish to insert the names,
then go to the Edit menu and choose Paste (I will insert the list

of Gramps tutorials directly into this article:)
& Pages Fil@sen Format Arrange View

‘o0 @ o Typing #Z
Dv LJ Redo 38Z
View Outline Cut 38X
QL Jld | 38C

Pages
~peste=afd Match Style 038V

Delete
Delete Pages...
Clear All
Duplicate 0 ‘hoos
Select All #A Drorr
Deselect All T8A o pa
Teanl: Nhancan fo

9. That’s it!

Apple-Q HowTo- Gramps- Attaching Media (2017-11).pdf

Apple-Q HowTo- Gramps- Backup your Family Tree (with Media)(2018-07).pdf
Apple-Q HowTo- Gramps- Clean up your Media Paths (2019-06).pdf

Apple-Q HowTo- Gramps- Consolidating Media Files (2019-06).pdf

Apple-Q HowTo- Gramps- Contextual Configuration Settings (2021-10).pdf
Apple-Q HowTo- Gramps- Custom Installation (2019-06).pdf

Apple-Q HowTo- Gramps- Export Family Tree as GEDCOM (2020-02).pdf
Apple-Q HowTo- Gramps- Have these two families met? (2019-06).pdf

Apple-Q HowTo- Gramps- Import Family Tree from Backup (2018-07).pdf
Apple-Q HowTo- Gramps- Import Family Tree from GEDCOM (2019-06).pdf
Apple-Q HowTo- Gramps- Import Family Tree with Media (2022-05).pdf

Apple-Q HowTo- Gramps- List of Tutorials (2022-03).pdf

Apple-Q HowTo- Gramps- Map all known places (2019-06).pdf

Apple-Q HowTo- Gramps- Organise & Find Places (& GPS)(2019-06).pdf
Apple-Q HowTo- Gramps- Transfer to another Mac (Custom Install)(2019-06).pdf
Apple-Q HowTo- Gramps- Transfer to another Mac (Standard Install)(2019-06).pdf
Apple-Q HowTo- Gramps- Video Tutorials (Richard Suthern)(2018-01).pdf



Apple-Q HowTo Tutorials by Leigh Harvey

There are around 400 Apple-Q HowTo Tutorial available to all
Apple-Q Members. In the beginning, before any HowTo Tutorials
even existed, I used to create a long email or text document (with
screenshots) every time that a member asked me for a detailed step-
by-step explanation on how to solve a problem that they had with
their Mac. However I soon found that many members were often
contacting me with the same problems.

This was even worse when members asked me to describe what to
do over the phone without me being able to see their Mac. I often
found myself trying to describe what they should be seeing on their
screen and what to do next. I soon refined the help documents that I
send members to include a large screenshot to go with each simple
step that I gave them.

I then started to search back through my emails to members trying
to find where I had previously sent a member a help email on a
given topic in order to send that to another member who was asking
the same questions. I found this very hit-and-miss and it was often
faster to recreate it from scratch.

So I started to use LibreOffice to create these help instructions and
save them within a single folder (with a descriptive titles to help me
locate them in the future). So I would just send members who asked
the PDF version of the file on How To solve their problem. These
later gained the title ‘Apple-Q HowTo Tutorials’.

The trouble with the evolving way that these tutorials came about
was that many of the early versions did not have a consistent
structure, design, or layout. Also many of the links to external
information became defunct or no longer relevant. One example of
this was where I stored them. Initially I saved them on my personal
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web server and sent out links to these tutorials to members. Later I
started to use a great ebook app called calibre to organise and create
a separate web site for them. A few years back this site was finally
placed within a sub-domain of the apple-q.org.au site (core.apple-
g.org.au).

5. Logging in the first time could take a while as it needs to download so structure
information:

Logging in ...

Apple-Q HowTo Tutorial (hitp:/iwww.apple-g.org.au) @ by Leigh Harvey (2020)

existed - this had to be corrected. So I set about updating close to
450 Apple-Q HowTo Tutorials to create a consistent ‘look-and-feel’
as well as fix outdated information and bad links. This took me
longer than expected but it was recently completed - however 40 to
50 tutorials were totally defunct. I did keep a complete copy of these

10


https://calibre-ebook.com/
https://calibre-ebook.com/

Apple-Q HowTo Tutorials by Leigh Harvey

tutorials on the Apple-Q-Cloud with ‘(old versions)’ added to the
folder’s title:

L] Name
Apple-Bug Magazines

( Apple-Q HowTo Tutorials )

Apple-Q General

C Apple-Q HowTo Tutorials (old versionsD

Apple-Bug Selected Articles

Also while I was making all of these changes I also consolidated
many of the tutorials into folders that I hoped would better aid in
locating the item that members needed (see right).

In the final page of this article there is a full list of the topic folders
along with individual tutorials that did not ‘fit’ within a particular
topic folder.

These HowTo Tutorials can be accessed from all three of our Apple-Q
web sites (apple-qg.org.au, cloud.apple-q.org.au and core.apple-
g.org.au).
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The Apple-Q-Cloud is easiest to copy multiple tutorials from (see
this tutorial):

O

Name

- Apple-Q HowTo- Apple-Q Services (Network & Internet)
- Apple-Q HowTo- macOS

- Apple-Q HowTo- Apple Preview

- Apple-Q HowTo- Family History

. Apple-Q HowTo- Internet

- Apple-Q HowTo- AirDrop

- Apple-Q HowTo- Scanner

. Apple-Q HowTo- eBooks

- Apple-Q HowTo- Backup & Sync

. Apple-Q HowTo- Photos,Editing,Images

- Apple-Q HowTo- File Transfer,Sync,Share
. Apple-Q HowTo- Finder,Dock,Mission Control
- Apple-Q HowTo- Server Setup

- Apple-Q HowTo- VirtualBox
11


http://www.apple-q.org.au
http://www.apple-q.org.au
https://cloud.apple-q.org.au
https://cloud.apple-q.org.au
https://core.apple-q.org.au/#book_id=1574&library_id=Apple-Q-Core&panel=book_details&vl=Apple-Q%20HowTo%20Tutorial
https://core.apple-q.org.au/#book_id=1574&library_id=Apple-Q-Core&panel=book_details&vl=Apple-Q%20HowTo%20Tutorial
https://core.apple-q.org.au/#book_id=1574&library_id=Apple-Q-Core&panel=book_details&vl=Apple-Q%20HowTo%20Tutorial
https://core.apple-q.org.au/#book_id=1574&library_id=Apple-Q-Core&panel=book_details&vl=Apple-Q%20HowTo%20Tutorial

Apple-Q HowTo Tutorials by Leigh Harvey

The Apple-Q-Core has an brief outline of each tutorial:

# Apple-Q-Core

Showing Virtual library: Apple-Q HowTo Tutorial

Apple-Q HowTo- Firefox: Secure Cookies & Exceptions 2022.05 of Apple-Q HowTo Tutorial
Leigh Harvey

Site cookies were originally designed to store your preferences for a particular web site however some sites abuse this by collecting additional personal data. Some cookies can even track you across multiple sites (called cross-
site cookies). You could totally block cookies however many sites do not function correctly if you do this.

There is a compromise. You can choose to block cross-site cookies, delete all cookies when you close Firefox, and even add exceptions for those sites that you trust (like Apple-Q & ).

Mava fa bac.

Apple-Q HowTo- Apple-Q Web Sites: Easy Access (Safari) 2022.05 of Apple-Q HowTo Tutorial
Leigh Harvey

Now that the Apple-Q and the Apple-Q-Cloud sites are linked (requiring a single login) it has become very easy to navigate between these sites and the Apple-Q-Core site via the Members’ Abyss menu on the main site. If you
have your log in details saved you can even do so (almost) seamlessly.

Here is how...

Apple-Q HowTo- Apple-Q Web Sites: Easy Access (Firefox) 2022.04 of Apple-Q HowTo Tutorial
Leigh Harvey

Now that the Apple-Q and the Apple-Q-Cloud sites are linked (requiring a single login) it has become very easy to navigate between these sites and the Apple-Q-Core site via the Members’ Abyss menu on the main site. If you
have your log in details saved you can even do so (almost) seamlessly.

Here is how...

Apple-Q HowTo- Gramps- Import Family Tree with Media (2022-05) 2022.05 of Apple-Q HowTo Tutorial
Leigh Harvey

One of the biggest problems that | have had with importing my family trees into an application is making certain that the media remains attached to the entries in my imported family tree. The biggest problem is when
that media is placed all over the drive and not in a single location. | have covered this in another tutorial but the best thing that you can do is to make sure that you place all of your media within a dedicated folder before you attach
it to your family tree (no matter what app you are using).

If you are transferring your family tree between two different Gramps installations then you should Backup your family tree using Gramps then

Apple-Q HowTo- Apple-Q-Cloud Sync (2022-05) 2022.05 of Apple-Q HowTo Tutorial
Leigh Harvey

Ever wanted to have the whole Apple-Q HowTo Tutorial collection immediately available on your Mac and have it automatically update whenever a new tutorial is created? It can be done. In fact | use this feature to
backup the entire Apple-Q-Cloud to two other Macs

The NextCloud Server that we use to power the Apple-Q-Cloud has a Desktop app that you can use to sync all or part of the contents of a NextCloud Server that you have access to — in this case the Apple-Q-Cloud.
Here is how...

Apple-Q HowTo- Apple-Q-Cloud- New Apple-Q Tutorial Alert (2022-05) 2022.05 of Apple-Q HowTo Tutorial
Leigh Harvey

The is a very underused feature of macOS called Folder Actions. It allows you to attach an action to a folder in the Finder. The screenshot below shows some of these. In this tutorial | am going to add a Folder action that
watches the Apple-QHowTo Tutorial (Synced) folder an alert you when a new tutorial has been added.

Here is how...

Apple-Q HowTo- Apple-Q-Cloud- Calendar Sync (Mac)(2022-05) 2022.05 of Apple-Q HowTo Tutorial

| sinh Harvev
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Apple-Q HowTo Tutorials by Leigh Harvey

The third location is on the new Apple-Q main web site.

This list contains all of the items within the Apple-Q-Cloud Apple-
Q HowTo Tutorial folder. There are about 400 tutorials. The
entries with .pdf after their names are individual tutorials that did not
fit under a specific topic folder title. Those items without the .pdf are
folders that contain several tutorials about that a topic.

Apple-Q HowTo- Adobe Flash Uninstall (2017-09).pdf
Apple-Q HowTo- AirDrop

Apple-Q HowTo- AntiVirus

Apple-Q HowTo- Apple Numbers

Apple-Q HowTo- Apple Pages

Apple-Q HowTo- Apple Preview

Apple-Q HowTo- Apple-Q Forms

Apple-Q HowTo- Apple-Q Services (Network & Internet)
Apple-Q HowTo- Apple’s Markup Tools (2019.03).pdf
Apple-Q HowTo- Audio,Music,iTunes

Apple-Q HowTo- Backup & Sync

Apple-Q HowTo- Clean Your Mac

Apple-Q HowTo- Clonezilla

Apple-Q HowTo- Create Linked PDF Files

Apple-Q HowTo- Default App for your Digital Imaging Device
(2016-03).pdf

Apple-Q HowTo- Disk Utility

Apple-Q HowTo- DVD or CD Duplication Using Burn (2015-03).pdf
Apple-Q HowTo- eBooks

Apple-Q HowTo- Emoji, Symbols, and Keyboard Viewer
(2016-03).pdf

Apple-Q HowTo- Family History

Apple-Q HowTo- File Transfer,Sync,Share

Apple-Q HowTo- Finder,Dock,Mission Control

Apple-Q HowTo- Free & Open Source Software- MacUpdate.pdf
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Apple-Q HowTo- Harvey Christmas Village- Access & Use.pdf
Apple-Q HowTo- Internet

Apple-Q HowTo- i0S-iPadOS (iPad-iPhone)

Apple-Q HowTo- Join Be Connected (2018-09).pdf

Apple-Q HowTo- LibreOffice

Apple-Q HowTo- Mac Speed Tests- Mac Upgrade (2016-02).pdf
Apple-Q HowTo- macOS

Apple-Q HowTo- Mail

Apple-Q HowTo- Networking

Apple-Q HowTo- Own Private Cloud

Apple-Q HowTo- Photos,Editing,Images

Apple-Q HowTo- Printer

Apple-Q HowTo- Scanner

Apple-Q HowTo- Screenshots

Apple-Q HowTo- Scribus Install plus GhostScript(2015-07).pdf
Apple-Q HowTo- Server Setup

Apple-Q HowTo- Simutrans Install (Transport Simulator)
(2017-08).pdf

Apple-Q HowTo- Spell Check - Australian Spelling

Apple-Q HowTo- Subscribe to MacMost Podcasts (2019-04).pdf
Apple-Q HowTo- Tutorial Blank (2022-03).ott

Apple-Q HowTo- Video,Movie

Apple-Q HowTo- VirtualBox

Apple-Q HowTo- Windows Apps on Your Mac (Wine 32Bit Only,PAF)
Apple-Q Intro to Digitising Your Memories (2018-03).pdf

As stated earlier these tutorials were all developed from questions and
problems that fellow Apple-Q Members have asked over the years. So
if you do not see a tutorial that helps you with your problem then
please contact the Apple-Q Help Line (email, phone, or speak to other
members (including me) on the Apple-Q Meetings server.
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Information: Help Apple-Q: Joining Be Connected & Tutorials (Mac/iOS) by Leigh Harvey

During your time of enforced confinement would be a good time to
increase your basic computer skills. It is good to keep your mind
active and set tasks for yourself. Be Connected has an ever increasing
collection of tutorials that you can work through. You will also be
helping Apple-Q achieve our goals and receive more funding.

The people signing up and achieving this goal do not have to be Apple-
Q Members they just have to select Apple-Q Inc as their Support
Centre. The funding that we receive is also dependent on the number
of seniors (aged 50+) that we support so it would be good to have
those signing up being in this category. So tell all of your friends and
in doing so help them to keep their mind active. Download the full
tutorial (see the bottom of this page for the link) and send it to them.

Note: Be Connected is run by the Australian Government, which
already have the data that you are entering (date of birth, address, etc)
but you need to enter it correctly to verify that you are a real person.

The following is a tutorial on how to sign-up with Be Connected with
Apple-Q as the designated Support Centre.

Signing Up to Be Connected

Be Connected in conjunction with Good Things Foundation are
helping Australians Learn a new skill from home, or at a nearby
community centre or Network training partner (like Apple-Q). Join
thousands of Australians who are taking our free courses on
everything from how to access the internet, to using your device and
keeping in touch with others online.

Here is how to join...
(Full tutorial available at: (Apple-Q HowTo- Join Be Connected)
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1. Use this link to connect to Be Connected then click on the Sign/up

link at the top right:

I GGIGEE Topic library  Find local help  Help others  Network Partners Resizetext A A A |

S Be Connected

Aunstralisn Governmese E

Learn a new skill fro
home, orat a nearby
community,centre.

Join thousands of Australians who are
taking ounfree cous 3
how to acces

device and keep
[LULEN

Start learning >

2, Then click on Create new account at the bottom right:

Is this your first time here?

Hi! For full access to courses you'll need to take a minute to create a new
account for yourself on this web site. Here are the steps:

Sign in
Already have an account?
Use your account details to sign in.

Email @.' 1. Click 'Create new account' button

Password l_;l 2. Fill the short form with some information about you
(so we know it's you next time)

Remember username
N,

m ‘ 3. Click 'Sign up for free' button

Forgotten your username or password?

Cookies must be enabled in your browser €)

IEEF' 4. start exploring!
‘ P 4

‘ Create new account > '
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Information: Joining Be Connected & Tutorials (Mac/iOS) by Leigh Harvey (cont...)

3. Enter your details in the relevant boxes and select Apple-Q Inc as 4. Tick the box indicated below after reading the terms and
Name of Support Centre as shown below, then scroll down...: conditions (and choosing any other options that you wish) then
click on Sign up for free at the bottom:

There are required fields in this form marked *.

. Newsletter and survey consent
Your details

| consent to receive emails

from Be Connected ©
First name* ©

| wish to participate in a

phone survey ©

Last name* @ My phone number ©
B * = = e The eSafety Commissioner is collecting your personal information for the purpose of
Date of birth* © 20 & September S 2018 T & registering you with the Be Connected website, which is produced and maintained by the
eSafety Commissioner in partnership with the Department of Social Services.
* . ks E =
Gender* O Please choose a For more 1nforma|on on why we need this information and how we'll handle it, please see

Residential address* @ By signing up you agree to the terms and

conditions of the Be Connected site.

Name of support centre © Apple-Q Inc

| 2

Sign up for free > ) Cancel >

,o Your sign in details . .
5. If all goes well you should then see the following. That is all that

you have to do to sign up. If you wish to view the learning topics
click on View the topic library:

Email address* o

*
Password Show password

The password must have at least 7 characters, at least 1 digit and at least 1 upper case

letter Welcome to Be Connected Your details

Your Be Connected account has been created and you're ready to get started. You can update your details at any time

by clicking on your name at the top of
View the topic library >

the screen and then going to the My
Profile page.
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Information: Joining Be Connected & Tutorials (Mac/iOS) by Leigh Harvey (cont...)

6. You may then choose to Start a learning plan, search topics, or
scroll down and view the many topics that are available: VQ Apple iPad: Getting started

Tell us a little about yourself and we'll create

New to the world of tablets? Learn how to get started on your iPad with helpful, step-by-

a learning plan just fOI’ you, step videos and a fun interactive guide that shows you all the features you need to know
about.
e Interactive guide e Customising system settings
I i lan>
Startyour leamning plan e Setting up your new or used iPad e Using the keyboard
e Security and privacy e Connecting to Wi-Fi

o |lceful featiirec

Search >

‘% Apple iPhone: Getting started

Toplc ].].b I'ary Getting started on your iPhone is easier than you may think. This topic shows you how to

set up and customise your iPhone with helpful step-by-step videos and a fun interactive
guide that shows you all the features you need to know about.

e Interactive guide e Customising system settings
Essentials e Setting up your new or used iPhone e Adjusting quick settings
e Security and privacy e Managing notifications

e Useful features

vl bl The absolute basics m
Apple desktop: Getting started
This course will teach you the absolute essentials of using your device, whether it is a

desktop computer, laptop, tablet or smartphone.
Set up and personalise your Apple desktop computer (or iMac) with helpful, step-by-step
videos and a fun, interactive guide that shows you all the features you need to know

about.
® |nteractive guide e Helpful features
] . . ® Setting up your new or used iMac e Customising settings
&D Getting to know your device ® Security and privacy ® Managing files and storage
This course will teach you the basic functions of a keyboard, a mouse and a computer, ...and many more. TI‘y them and in doing SO help App]e_Q!

incliiding how ta rhanee <ettings and manage vniir file
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Gramps: Video Tutorials (Richard Suthern) (Mac) by Leigh Harvey

Gramps

Genealogical Research Software

<5

Research, organise and share
your family tree with Gramps.

Gramps is a free software project and
community. We strive to produce a
genealogy program that is both
intuitive for hobbyists and feature-
complete for professional
genealogists. It is a community
project, created, developed and governed by genealogists.

(https: introduction-WP/)

Richard Suthern has created a good series of video tutorials. I have

copied the data from his videos and inserted it as text within this
tutorial — simply copy and paste it for the associated tutorial.

ramps-project.or

So open Gramps, download the videos and copy the associated Data
for the tutorial from the following pages (if any) then watch the video

pausing it when you need to copy the info into the Gramps family tree.

Enjoy!

Gramps Site:

All that you have to do is download Gramps open the disk image, and
copy the Gramps app to your Applications folder.

Video Tutorials by Richard Suthern (in order):
Gramps Genealogy Software v4.1.1 - overview:

https: EZ1Dzirwc

Gramps Genealogy Software - create a new tree part 1:

www.youtube.com/watch?v=
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https://www.youtube.com/watch?v=ato3noZQ6hY

Gramps Genealogy Software - create a new tree part 2:
https://www.youtube.com/watch?v=irNEaIR_vak

Gramps Genealogy - testing options:
https://www.youtube.com/watch?v=CYUBZuWhjfM
Gramps Genealogy - Using places in version 4.1.3:
https://www.youtube.com/watch?v=z_SvavotViw

I have written the following tutorials about Gramps:

Link to the Apple-Q-Cloud Gramps tutorial folder

Apple-Q HowTo- Gramps- Custom Installation;

Apple-Q HowTo- Gramps- Video Tutorials (Richard Suthern);
Apple-Q HowTo- Gramps- Import Family Tree from GEDCOM;
Apple-Q HowTo- Gramps- Export Family Tree as GEDCOM;
Apple-Q HowTo- Gramps- Attaching Media;

Apple-Q HowTo- Gramps- Consolidating Media Files;

Apple-Q HowTo- Gramps- Backup your Family Tree (with Media);
Apple-Q HowTo- Gramps- Import Family Tree from Backup;
Apple-Q HowTo- Gramps- Transfer to another Mac (Custom
Install); Apple-Q HowTo- Gramps- Transfer to another Mac
(Standard Install); Apple-Q HowTo- Gramps- Have these two
families met?;

Apple-Q HowTo- Gramps- Map all known places;

Apple-Q HowTo- Gramps- Organise & Find Places (& GPS); Apple-Q
HowTo- Gramps- Contextual Configuration Settings; Apple-Q
HowTo- Side-by-Side Map Viewer

Apple-Q HowTo- Gramps- Clean us your Media Paths

And probably others since this tutorial was written.
(updated 2022-03)
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Jude’s Findings by Jude Hall & Leigh Harvey

When we produced the Apple-Q Disk of the Month there was Getting Started

always a folder which contained web links that Judith Hall had sent If you want to learn how to use Vectornator, then this page is for you!
to me via email. There were lots of interesting tidbits of interest to Here, you'll find everything you need to start designing. Become
Jude, me, and other members. So here are some of the things that familiar with Vectornator's tools, shortcuts, gestures, and powerful
she has found in the last month: features for cleaner projects and a faster workflow.

Vectornator Academy Online Courses
The Most Intuitive and Precise Illustration Software.

Vectornator empowers you to design anything you can imagine up to
30% faster. Create sophisticated illustrations, spectacular layout
mockups, and expressive lettering on the go, whenever you want.
Whether you're looking to expand your skills or tackle the next
challenge, our tutorials and courses will help you to master vector
design on a professional level.

Auto Trace for illustration

Tools

Learn how to use the different tools in Vectornator.

Selection Tool Pen Tool Pencil Tool

24 »
* Select paths and anchor points with 2 Create vector shapes and Bézier u' Draw smooth vector paths using
the Selection and Node Tool. curves with the Pen Tool the freehand Pencil Tool

Brush Tool Shape Tool Scissor Tool

“ Use preset brushes to create your . Create preset geometric shapes like %‘) Easily split your paths into seperate
own paths with variable widths. polygons and stars. parts with the Scissor Tool.
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Jude’s Findings by Jude Hall & Leigh Harvey (cont...)

Vectornator on iPad

Vectornator is a powerful vector design platform packed with amazing
features and offers an all-in-one solution for your design needs.
Vectornator offers absolute versatility on your iPad. All of your design
needs are at your fingertips, with intuitive controls and powerful
tools.

Using Vectornator with the Apple Pencil on iPad simulates a paper-
like drawing experience. Alternatively, you can connect a mouse,
trackpad, or keyboard to your iPad to use Vectornator in an
unmatched desktop experience.

How to edit a PDF

Editing a PDF doesn't have to be difficult! Whether you want to
change text or images in a PDF, or you want to sign a PDF document,
you can do it quite easily in Vectornator.

Note: Chris also found a MacWorld article on the Best free PDF
editors for Mac . I use LibreOffice to create all of Apple-Q’s PDF
Entry forms.
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Jude’s Findings by Jude Hall & Leigh Harvey (cont...)

Apple Adds Eight More Macs to Vintage Products List MacBook Pro (13-inch, 2016, Four Thunderbolt Ports)
As expected, Apple today updated its vintage products list with eight MacBook Pro (15-inch, 2016)

more MacBook, MacBook Air, MacBook Pro, and iMac models iMac (21.5-inch, Late 2015)

released in 2015 and 2016. iMac (27-inch, Retina 5K, Late 2015)

9.7-inch iPad Pro models released in 2016 are now vintage as well.

A device becomes vintage once five years have passed since Apple last
distributed the device for sale. Vintage products are typically ineligible
for repairs at Apple Stores and Apple Authorised Service Providers,
unless spare parts remain available.

10th-Generation iPad With Major Design Changes
Reportedly in Production Ahead of September Launch

¢ MacRumors

Notably, the first MacBook Pro models with the Touch Bar are now
classified as vintage. Apple introduced the Touch Bar in October 2016
as part of a complete redesign of the MacBook Pro. Apple has since
removed the Touch Bar from higher-end MacBook Pro models, but it
is still available on the new 13-inch MacBook Pro with the M2 chip.
The full list of Macs that became vintage at the end of July:

MacBook (12-inch, Early 2016)

MacBook Air (13-inch, Early 2015)

MacBook Pro (13-inch, Early 2015)

MacBook Pro (13-inch, 2016, Two Thunderbolt Ports)

Apple’s rumoured 10th-generation iPad is currently in production and

will feature “major” design changes, according to a report from
Taiwanese website DigiTimes.
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Jude’s Findings by Jude Hall & Leigh Harvey (cont...)

The report did not provide any specific details about the 10th-
generation iPad’s new design, but rumours suggest the device will
feature a larger 10.5-inch display with slightly thinner bezels, a USB-C
port, and a flat-edged enclosure with a protruding rear camera. The
lower-cost iPad is still expected to have a Touch ID home button, but
recently leaked renders showed the device without a headphone jack
like other iPad models.

In addition to the redesign, the lower-cost iPad is rumoured to gain a
faster A14 Bionic chip and 5G support for cellular models. Other
devices with the A14 chip include the fourth-generation iPad Air and
all four iPhone 12 models.

Apple plans to launch the 10th-generation iPad in September,
according to DigiTimes, but sources cited in the report said they are
concerned about temporary power restrictions imposed by the
Chinese government on factories in China’s southwestern Sichuan
province. Amid an intense heat wave, power has been cut to industrial
users in 19 cities throughout the province until August 20 in order to
prioritise residential power supply, and all industrial power users
have been ordered to suspend all production during this period, the
report claims.

iPads are mainly produced in Sichuan by manufacturers Foxconn and
Compal, according to the report, which adds that a six-day shutdown
due to the power cuts would likely not impact overall production
efficiency in August. If the power restrictions are extended, however,
the report says mass production of products could be affected.

Apple unveiled the ninth-generation iPad at its September 2021 event
alongside the iPhone 13, Apple Watch Series 7, and sixth-generation
iPad mini. It was rumoured earlier today that the 10th-generation
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iPad is set to be announced at an October event, so we’ll have to see if
the device ends up being unveiled in September or October this year.
The ninth-generation iPad features a 10.2-inch display, an A13 Bionic
chip, a 12-megapixel front camera with support for the Center Stage
feature, and support for the first-generation Apple Pencil. The device
starts at (A$499) $329 in the United States and is available in Space
Gray or Silver colour options with 64GB or 256GB of storage.

Latest iOS 16 Beta Updates Battery Percentage
Options in Low Power Mode

Monday August 15, 2022 1:56 pm PDT by Juli Clover

The sixth beta of iOS 16 that was provided to developers and public
beta testers today focuses mainly on bug fixes and other under-the-
hood improvements, but it does make one small change to the battery
percentage status bar feature that was introduced in the prior beta.
When using Low Power mode, it is now possible to turn off the
percentage indicator that is shown in the status bar, something that
was not able to be done in the prior beta. The change was first noted
by gtosMac, and it is
useful for those who
do not like the
battery icon in the
status bar to show
the percentage.

S0s = 98

4:36

< Settings Battery

Battery Percentage

@,

Low Power Mode

Low Power Mode temporarily reduces background
activity like downloads and mail fetch until you can fully
charge your iPhone.
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New MacMost Video Tutorials from Gary Rosenzweig (

About MacMost: What is MacMost.com?

MacMost is a video podcast and blog that teaches you how
to use your Mac, iPad and iPhone. At MacMost.com you
will find more than 2,000 videos, a weekly newsletter, tips,

and recommendations. You can contact MacMost via email.

Gary Rosenzweig is the founder, producer and host of MacMost. He
has written more than 40 mass-market books on computers,
including the best-selling My iPad series. In addition, he develops
mobile and web-based games. He has dual background of computer
science and journalism with degrees in both. You can read more about
him here.

Stop Adobe Background Processes From Automaticall
Launching

If you have Adobe Creative Cloud installed then every time you start
your Mac the Creative Cloud app and a number of big background
processes will start automatically. If you don't use Adobe apps every
day, you may want to change this so none of it starts until you use
your first Adobe app.

Adobe Memory Hogs
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25 Things You Can Do With QuickTime Player

QuickTime Player is a lot more than just a simple video playback app. You
can record video too, record and play audio, do some basic editing, grab
frames, combine images and much more.

Memory Pressure and How Your Mac Uses Memory

Learn how your Mac uses memory and makes it seem like you have more
memory than you actually do by compressing and swapping memory. Learn
what Memory Pressure is and how you can use this measurement to improve
performance in extreme situations.
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How To Add Music In iMovie On a Mac

You can add music to your iMovie project from a file, from iMovie itself, or
your Music library. Once in iMovie, you can adjust it, fade, apply effects and
more. But be careful when adding music to make sure you take into account
copyright.

Adding Music In iMovie

Understanding Safari AutoFill

AutoFill in Safari makes it easy to fill in fields in forms on web pages with
your name, email address, passwords, credit card information and other
details. You can use it more effectively if you understand where the
information comes from and why it sometimes doesn't work as expected.
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Adding Your Pets As People In Mac Photos

Photos will easily mark pictures as containing people's faces, as long as they
are human. But you can also manually add your pets or anything you like to
the People feature manually.

Add Your Pets To Photos

Using A Shortcut To Get Your Mac Ready For a Presentation
There are many things you may need to remember to do before starting an
online or in-person presentation on your Mac. But creating your own custom
Shortcut, you can avoid forgetting to do something like quit apps, set the
volume, turn on a Focus mode and change your wallpaper. You can also have
it launch your presentation or website automatically.
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How To Make Signs With Mac Pages
You can easily create one-page signs in Mac Pages using Page Layout mode.

Add text, symbols, arrows, shapes, borders and more. Save them and reuse
them by changing text later on.

Make Signs With Pages
— gy T —

Using Editing Substitutions On a Mac

In the Edit menu under Substitutions you can control some automatic
behaviour that happens when you type on your Mac, such as two dashes
being replaced by a long dash or quotes converting to curly quotes
automatically.
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Printing Labels Using Mac Pages
You can easily create a simple labels template to print a list of addresses to

labels in Pages. The list can come from text or a Number spreadsheet. You
can also modify pre-made labels templates to work better.

Printing Labels From Pages

Creating Photo Collages and GIFs Using Mac Shortcuts
Learn how to use the Shortcuts app to make photo collages from the Photos
app or files. You can also build animated GIFs for sharing, or videos.

24


https://macmost.com/how-to-make-signs-with-mac-pages.html
https://macmost.com/how-to-make-signs-with-mac-pages.html
https://macmost.com/using-editing-substitutions-on-a-mac.html
https://macmost.com/using-editing-substitutions-on-a-mac.html
https://macmost.com/printing-labels-using-mac-pages.html
https://macmost.com/printing-labels-using-mac-pages.html
https://macmost.com/creating-photo-collages-and-gifs-using-mac-shortcuts.html
https://macmost.com/creating-photo-collages-and-gifs-using-mac-shortcuts.html
https://macmost.com
https://macmost.com

New MacMost Video Tutorials from Gary Rosenzweig (

Understanding Finder Window Position, Size and View Safari Cookies, Cache and Histo
Settings When you browse the web Safari will save data as cookies, cache and
When you open a new Finder window, it can be confusing as to why the new history. Learn what these are and how to control them.

window is at a specific location, size and view settings. Understanding the
difference between Finder windows and folder locations is key, as well as

knowing the difference between browsing and opening new windows, and C 00 kl €s, C ac h € & H Isto ry

what is remembered by the Finder. — gy =0 wrpen

Using TextEdit Instead of Mac Notes

While Notes has become a robust system on the Mac, using TextEdit has

How To Make Your PDF Files Smaller some advantages such as recovering deleted information, restoring from
Sometimes you need to create PDF documents that are small enough to Time Machine, and being able to store information alongside other files in a
upload or submit with a size restriction. You can use Preview to compress the project.

images in a PDF file, but you get better results with more control if you work

with the images in the original document. Te Xt E d it VS N Ote S

P Vg
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Building a Mac Shortcut To Easily Generate QR Codes

You can use the Shortcuts app to make QR codes that link to web pages.
Once you have a Shortcut, you can easily reuse it to share a QR code, save it
as an image, or even just copy to the clipboard to paste into a document you
are working on.

Building a Mac Shortcut To Add a Border And Caption To a
Photo
Learn some Shortcuts programming by following along and building a

Shortcut that adds a border and caption to a photo file and saves it as a new
file.
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Using Contact Groups On a Mac
You can create groups in the Contacts app on your Mac and use them to

quickly send emails to several people without needing to select each contact.
Groups can be used for organisation too, and can help in other apps like
Messages and Calendar in some situations.

Mac Contacts Groups

Viewing Calendar Events As a List and Other Tricks

There doesn't appear to be a way to view your Mac Calendar events as a list,
but it can be done if you know one trick. You can use the list to easily select
items, and then copy and paste them in a variety of ways. You can also print
or save a PDF list of events.

Calendar View As List
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Let Your iPhone Read Text To You Printable Mac Keyboard Shortcut Page For macOS
You can set your iPhone up so it can read the text of an article, webpage or Monterey
other content to you using Siri or another voice. Use this if you have a vision

) ) : ) : There are hundreds of keyboard shortcuts for Mac users. There are
issue or just want to listen to some content instead of read it.

Mission Control shortcuts, Finder shortcuts, system shortcuts,
application shortcuts and more. Many you can find by just looking

I P hon e Read Text Aloud through the menu bar for that application. You can find system ones

by looking in the System Preferences under Keyboard.

g;'::t,(dwa’f But some keyboard shortcuts are more useful than others. And some

are harder to remember than others.

So MacMost has compiled a list of our top “power user” keyboard
shortcuts for macOS 12.0 (Monterey). Here they all are on a single
PDF page, downloadable and printable: The MacMost macOS
Monterey Keyboard Shortcuts. Download it and pass it along!

Managing Badges On Your Mac, iPhone and iPad

. . . ~ macOS Monterey Keyboard Shortcuts
Badges are the red dots with numbers in them you see in the Dock on your macmost
Mac and over App icons on your iPhone or iPad. You can hide them on an ST ]t el P, paRar = mosew
app-by-app basis and something customise what they represent. vl ieimporl | [ =
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Committee and Assistants

Contact Details

Membership Fees

President « Leigh Harvey
............................ president@apple-g.org.au

Vice President « Colin Inglis

..................... vicepresident@apple-q.org.au
Secretary « Jeff Sellers

........................... secretary@apple-q.org.au
Treasurer « Garry Davidson
........................... treasurer@apple-q.org.au

Registrar « Garry Davidson

............................ registrar@apple-q.org.au
Editor - Bill Tinney

................................ editor@apple-qg.org.au
Resources Officer « Campbell Sharp

........................... resources@apple-q.org.au
Training Co-ordinator « Des McKay

............................. training@apple-q.org.au
Editor Assistant ¢ Les Isdale

.......................... editor-asst@apple-q.org.au
Editor Assistant « Chris Edmondson

.......................... editor-asst@apple-q.org.au

Webmaster « Vacant

........................ webmaster@apple-g.org.au

Welcoming Officer « Vacant

............................ welcome@apple-q.org.au
Catering Officer « Marcie Miller

Bundaberg Contact:
Bryan Dickie « (07) 4152 9049

brvan@widebay.net.aus
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Meetings: (Still pending) Art Building,
MacGregor State High School

Web: http://www.apple-qg.org.au/
ABN: 68589514 199

Software Copying

The unlawful copying of commercially produced
software (piracy) is not sanctioned by Apple-Q Inc.
and members who do so risk expulsion from the
Club.

Advertising Rates

The advertising rates (to be paid in advance) for a
single advert in the Apple-Bug are as follows:

Business Card Size ........cceeevveeneee. $10.00
Y4 PAZE evevereeereerieenieeseeesveesaeens $15.00
L3 PAZE ceeeeveeeeeeireeeeeeeee e $20.00
12 PABe .cocovveeiiieiiieeiieccieeee $30.00
Full Page .....cccceeeevveeecieeeereeeee, $50.00
Full Page — 11 Issues ................. $450.00

For details on how to submit your advertisements
or rates on multiple issues, please contact the
editor. Members may insert free advertisements
into the Apple-Bug.

Joining Fee: (First year only)............ $10.00
Adult/Family/Student per annum ....$20.00
Corporate per annum:....... ....eeeeeeeeeees $60.00

Disclaimer

The views expressed in articles printed in this
newsletter may not be the views of Apple-Q Inc. or
its members. The editor reserves the right to reject
or edit all articles submitted for publication, and
these articles may be reproduced in print and/or
electronic format as required for production of the
Apple-Bug.

Editor for this Month

Editor of this issue is Bill Tinney. Thank you to all
those persons who contributed to this issue.

Budding writers or those who have something of
interest - please send your submissions to:

editor@apple-q.org.au
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